Freedom
Tuning Systems

User Instructions for
Stage 1 Tuner CAN Bus

CAUTION: CAREFULLY READ INSTRUCTIONS BEFORE PROCEEDING.
NOT LEGAL FOR USE OR SALE ON POLLUTION CONTROLLED VEHICLES.

OVERVIEW
The Freedom Tuning System Stage 1 Tuner
CAN bus version is compatible with 2010 to current
Victory® CAN bus models. You can easily adjust your
fuel injection to match the requirements of performance
parts including free flowing exhausts, and low
restriction air filters. You can add or subtract fuel.
Installation takes only 10-15 minutes and
involves accessing four wires from the engine control
module (ECM) harness to add two Deutsch connectors
and connecting one ground wire. The unit is completely
encapsulated and impervious to moisture. With a very
low profile of only ½” and occupying a fraction of the
space required by competitive products, you won’t
have a problem finding a place to mount the unit.

Figure 1 – Stage 1 Tuner

You can make independent adjustments to the front
and rear cylinders.

INSTALLATION
1. If the motorcycle is equipped with a security
system, make sure the system is disarmed. Turn
off the ignition switch and disconnect the battery
ground cable before proceeding.
2. Find the engine control module (ECM). The ECM is
usually located under the seat or under a side
cover.
3. Follow the ECM wiring harness and conduit
leading toward the engine. Open enough of the
conduit to expose the wires inside. Refer to Figure
5 for wiring hookup and color codes.
4. Cut the following wires in the harness. In order for
the wire ends to line up with the new connectors,
cut the wires straight and in a position to allow for
clearance with the installed connectors.

You can use the mode and up/down pushbutton
switches to make fuel trim adjustments in the RPM and
throttle position ranges required by most applications.
The fuel trim value is displayed on a bright daylight
readable LED display.

ECM
Connector

Wire Color

Signal

Terminal 1

Violet/Pink

System Power

Terminal 53

Orange/Yellow

TPS

Terminal 25

White/Dk Blue

Injector Front

Terminal 26

White/Gray

Injector Rear

5. Install male Deutsch terminals on the wire ends
from the ECM connector. Install female Deutsch
terminals on the wires ends going to motorcycle
wiring harness. Terminals and connector housings
are in the parts bag supplied with the Stage 1
Tuner. Refer to the Appendix on page 12 for
suggested crimping tools and techniques.

The Stage 1 Tuner also has an advanced mode,
where you can use the optional USB interface and PC
Link Tuner software to make precise fuel adjustments.
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6. Insert the wires into appropriate four terminal
Deutsch housings and install the secondary locks.
Terminal numbers are marked on the back side:

Deutsch
Terminal
1
2
3
4

Wire Color

Signal

Violet/Pink
Orange/Yellow
White/Dk Blue
White/Gray

System Power
TPS
Injector Front
Injector Rear

Figure 3 – Typical Cross Country® Installation
(Others Similar)

7. Wrap electrical tape around the cable conduit and
secure with cable ties.
8. Mate the Deutsch connectors you installed on the
ECM harness with the Deutsch connectors on the
Stage 1 Tuner harness.
9. Connect the Stage 1 Tuner black ground wire to an
appropriate ground. You can generally find one or
more screws used for other ground connections
under the seat or near the ECM. The ground screw
at the rear of the fuel tank is a suitable ground
connection point.

Figure 4 – Typical Cross Country® Installation
(Others Similar)

10. The Stage 1 Tuner brown wire with Weather Pack
connector is the data link used for PC
communications. If not used, tape up this wire.

11. Find a location for the Stage 1 Tuner. You can use
Velcro material to secure the unit. For Cross
Country® models, the Stage 1 Tuner can be
mounted under the left side cover on the ECM as
shown in Figure 4.

Figure 2 – Typical Cross Country® Installation

12. Reconnect the battery ground cable. Do not
attempt to start the engine until you have
completed the initial setup.

13. If you need to remove the Stage 1 Tuner for
trouble shooting purposes, just disconnect it and
plug the two mating Deutsch connectors on the
ECM harness together.
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Figure 5 – Wiring Hookup

INITIAL SETUP

BASIC TUNING

The Stage 1 Tuner has a 10 position rotary
mode switch used to select fuel trim parameters to edit,
two digit LED display, and up/down pushbutton
switches to change the parameter value. Fuel trim
parameters are listed in Table 1. Note that the
rectangular LED to the left of the two digit LED is
illuminated for negative values. Values represent
percent fuel trim. You can use a small flat screwdriver
to rotate the mode switch. You can make parameter
changes on-the-fly with the engine running.

Table 1 shows the engine operating ranges
affected by fuel trim values in terms of RPM and
throttle position sensor (TPS) values. For tuning
recommendations and initial setup tables for common
applications refer to the Appendix starting on page 9.

Before starting the engine for the first time, turn
the ignition switch and run/stop switch on. The idle air
control motor will move to the starting position and the
fuel pump will be energized for several seconds,
making an audible buzz. Set the mode switch from
each position from 0 to 9. The LED display should be
off in position 0. The LED display should illuminate and
read 00 in positions 1-9 (unless your Stage 1 Tuner
has been preprogrammed with a base map file or for
some specific application). If required, use the up/down
pushbuttons to set the values for each position to zero.
Start the engine and verify normal operation. If the
engine will not start, or runs on one cylinder, recheck
connections.
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Table 1 – Mode Switch Settings
Parameter

Fuel Trim Operating Range

0
1
2
3
4
5
6
7
8
9

Display off – used to prevent inadvertent changes during normal engine operation
Idle 750-1250 RPM 0% TPS
Low cruise 1250-2000 RPM 2.5-50% TPS
High cruise 2000-3750 RPM 2.5-50% TPS
Wide open throttle 1250-2000 RPM 50-100% TPS
Wide open throttle 2000-2750 RPM 50-100% TPS
Wide open throttle 2750-3750 RPM 50-100% TPS
Wide open throttle 3750-4750 RPM 50-100% TPS
Wide open throttle above 4750 RPM 50-100% TPS
Acceleration enrichment (0 = none, 10 = maximum)

ADVANCED TUNING
The Stage 1 Tuner also has an advanced mode,
where you can use the optional USB interface and
Windows software to check and observe system
operation (Tuner Log) and make precise fuel
adjustments (PC Link Tuner).

PC REQUIREMENTS
The Stage 1 Tuner connects to your PC by
means of an optional USB interface (P/N USB-INTFPT) that is also used with our other engine controls.
The PC must have a free USB port. If you have an
older PC without USB capability, you cannot use the
advanced tuning capability.
We recommend a laptop PC with Pentium
processor and super VGA display (SVGA with 1024 x
768 pixel resolution) running Windows XP/Vista/7.
Data display is graphics intensive and a high speed
Pentium processor is recommended. Processors
slower than 300 MHz will exhibit sluggish program
loading and response. The PC must have a CDROM
drive for program loading.
PC Link Tuner software includes print
commands to print downloaded data. The program has
been tested with Hewlett-Packard laser and inkjet
printers and Epson inkjet printers. We recommend
using a color inkjet printer.

SOFTWARE INSTALLATION
The software is supplied on CDROM media or in
the form of a compressed file downloaded from our
website. The installation process uses InstallShield.
This industry standard installer is based the new
Microsoft Windows Installer service that greatly

reduces potential problems such as version conflicts
and allows for application self-repair.
There are two programs to install: Tuner Log and
PC Link Tuner. Start by installing Tuner Log. If you are
downloading software from the web, only download and
install one program at a time. Before proceeding with
installation, shutdown any other applications that may be
running. For Windows Vista, you must disable the User
Account Control (UAC) during installation.
Use the Windows Explorer or the Run command
from the Windows Start Menu to launch setup.exe in the
Tuner_Log folder on the CDROM or the setup.exe file
downloaded from our website. InstallShield will install the
software in an appropriate folder under Program Files.
Repeat the installation process for PC Link Tuner.
Use the Windows Explorer or the Run command from
the Windows Start Menu to launch setup.exe in the
PC_Link_Tuner folder on the CDROM or the setup.exe
file downloaded from our website. InstallShield will install
the software in an appropriate folder under Program
Files.
Once InstallShield has completed the
installation, Tuner Log and PC Link Tuner will appear
on the Windows Start Menu. You can then launch them
just as you would any other Windows program.
PC Link Tuner software requires the Monospace
821 BT fixed pitch printer font in order to properly align
columns when printing. The Monospace 821 BT font is
included in the distribution media and automatically
copied to your Windows Fonts folder during
installation. A backup copy is also placed in the
program folder. If you accidentally delete this font, use
the Install New Font command from the Fonts folder
File menu. The filename associated with Monospace
821 BT is monos.ttf.
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CONNECTION
DO NOT plug in the USB Interface until the USB
Driver software is installed to avoid potential conflicts
with your PC. Follow the instructions supplied with the
optional USB interface to install the required USB
drivers and configure the COM port. Once you have
configured a COM port number for your new USB
Interface, make sure that you use this same COM port
selection in the Tuner Log and PC Link Tuner software.
The USB Interface has a selector switch…be sure to
use the “B” switch setting.
An adapter harness is supplied with the USB
Interface for use with the Stage 1 Tuner. Connect the
alligator clip on the black wire to any ground such as a
bolt on the engine, and the Packard Weather Pack
connector to the mating connector on the brown wire
from the Stage 1 Tuner.
Turn the ignition key and engine run/stop switch
on to provide power to the system. Do not start the
engine if you want to download or upload data with PC
Link Tuner.

TUNER LOG SOFTWARE
When the engine is running, you can display real
time engine data on an instrument panel type screen
as shown in Figure 6 by using the View Real Time
Data command on the View menu.

You can also check proper operation of the
throttle position sensor (TPS) when the run/stop switch
is on (engine not running). Rotate the throttle through
the full range of motion. The TPS% value should go
from zero to 100%.
Real time engine data is displayed on an
instrument panel type layout with a round tach gauge
and bar graph type gauges for all other parameters.
Status messages are displayed in a separate window.
If the engine is not running, most values will appear as
zero or off.
Displayed parameters include:
RPM – engine crankshaft RPM (numeric value
displayed beneath gauge)
TPS – throttle position (0 to 100%)
BAT – battery voltage
FRONT INJ PW, REAR INJ PW – injector pulse
width in milliseconds (pulse width commanded
by ECM before fuel trim by Twin Tuner)
FRONT FUEL%, REAR FUEL% – fuel trim in
percent (0% means no change)
STATUS – engine running status and basic
mode (switch settings used to trim fuel) or
advanced mode (PC Link Tuner tables used to
trim fuel)
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Figure 6 – Real Time Engine Data Display

PC LINK TUNER SOFTWARE
Before the engine is started, you can download
or upload data with PC Link Tuner.
After PC Link Tuner is launched, the main
screen appears blank. You have two options for
obtaining data for editing. You can open a previously
saved data file by using the Open File command on the
File menu or you can download data from an attached
Stage 1 Tuner unit by using the Download Data From
Twin Tuner command on the Communications menu.
Note that Stage 1 Tuner data files use a .dat extension.
You should create a separate folder to store these
files.
Once you have Stage 1 Tuner data, you can edit
various 3D tables and parameters. 3D fuel trim tables
are accompanied by chart displays that help visualize
the data. You can also rotate the 3D chart display for a
better view of a particular region. You can print the
data associated with an active table or Stage 1 Tuner
parameters by using the appropriate Print command
from the File menu. When you open a file or download
data from a Freedom Stage 1 Tuner, the data is stored

in a buffer memory. After editing a table, you can save
the edits to this buffer memory. Once you have
completed all your edits, you can save the data in
buffer memory to a file or upload it back to the Twin
Tuner by using the appropriate command from the File
or Communications menu.
Please note that communication is only possible
if the ignition key and run/stop switch are turned on
and the engine has not yet been started.

TUNING PARAMETERS
Stage 1 Tuner parameters shown in Figure 7
control the overall operating mode of the unit and allow
you to preset parameters without using the switches on
the unit. Options and parameters that you can set
include:
Stage 1 Tuner Version – when a file is opened
or data is downloaded, the software automatically
determines the Freedom Stage 1 Tuner version. Do
not use EX version files or click on the EX option with
the standard (race) Stage 1 Tuner.
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Basic Mode – fuel trim values are based on
switch settings. This is the default operating mode.
Advanced Mode – fuel trim values are based
on the 3D front and rear cylinder fuel trim tables.

grayed out in basic mode. If this option is selected,
switch settings 1 to 8 can be used to manually trim the
3D fuel tables. If this option is not selected, switch
settings 1 to 8 are ignored (switch setting 9 for
acceleration enrichment is still active).

Injector Swap on Enrichment Mode – positive
fuel trim is applied to the opposite injector to
compensate for fuel distribution problems in some
applications. This mode is not normally selected. Refer
to tech support for additional details.

Parameters 1-9 – display fuel trim parameter
values. Can be used to edit or preset values without
using the switches on the unit. Fuel trim parameters
are listed in Table 1.

Enable Manual Trim in Advanced Mode – this
option is only available in advanced mode and is

User Data – you can enter up to 32 characters
of user data that will be saved in EEPROM memory.
User data can contain comments or serial numbers.

Figure 7 – Freedom Stage 1 Tuner Parameters

EDITING 3D TABLE DATA
You can edit the front and rear cylinder fuel trim
tables. Before you can edit one of these tables, you
must either open a data file or download data from a
Stage 1 Tuner. Numeric data is always edited on the
spreadsheet grid. The front and rear cylinder fuel trim
tables are accompanied by 3D graphs that help
visualize the data.
Each table consists of 18 rows from 500 to
6,500 RPM and 9 throttle position columns from 0% to
100%. The 6,500 RPM value is used at all higher RPM
levels.
After you have edited a table, you must use the
Save Table Edits To Buffer command from the Edit

menu to save your edits to buffer memory. If you use
the Close Table command from the Edit menu, all your
edits are lost.

Front and Rear Cylinder Fuel Trim Tables
The fuel trim values in these tables are only
active if advanced mode is selected. You can enter fuel
trim values from -20% to +30% in every cell. Unless
you have specific experience in trimming individual
cylinders and the associated fuel distribution problems,
we suggest that you use the same values for both front
and rear cylinders. You can edit a table for the front
cylinder. After saving the table edits to buffer memory,
you can use the Copy Front Cylinder Trim to Rear
command from the Edit menu to quickly copy the entire
table.

Pro Twin Performance Products, 362 Swanson Drive, Lawrenceville, GA 30043
(678) 226-9651 www.protwin.com
Page 7

Freedom Stage 1 Tuner CAN
12/2013

Figure 8 – Typical Front Cylinder Fuel Trim Table

Editing Table Data
You can edit table data using standard Windows
copy and paste operations by selecting cells and then
clicking the right mouse button to pop-up the edit
menu. You can select cells by dragging the mouse with
left button down. You can also use the Modify
command on the pop-up menu. When you enter a
value, the presence of optional sign (+ or -) or percent
(%) characters affects the outcome of the Modify
command as shown in Figure 9.

Figure 9 – Modify Command

Data Export and Import by Means of Copy
and Paste
You might want to export or import 3D table data
to or from another application such as Microsoft Excel
and other programs with tables that support copy and
paste operations. You can directly copy and paste data
to and from the PC Link Tuner program. In the PC Link
Tuner program, you can select a range of cells with the
mouse and right click to bring up a copy and paste
menu. When you paste data into the PC Link Tuner
program, the data is automatically checked and any
out-of-range data corrected.

Chart Operations
You can rotate the 3D chart display for a better
view of a particular region by dragging the mouse while
holding both mouse buttons down.
PC Link Tuner is intended to be an open system
and uses the Component One Chart 7.0 3D charting
control. The adventurous user can experiment with the
chart property pages by right clicking on the chart.
Almost any chart property can be changed. Click on
the Help button for more information. If you corrupt the
chart, exit and restart PC Link Tuner.
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APPENDIX – INITIAL SETTINGS
Use the flow chart to select the best initial
settings for your application. Stage 1 Tuner series is
appropriate for most Stage 1 (low restriction air filter
and free flowing exhaust) and Stage 2 (mild
performance camshafts) applications.
Most Victory® models are equipped with dual
narrow-band oxygen sensors and an ECM that
supports closed loop air/fuel ratio (AFR) control based
on feedback from the sensors. After the engine has

warmed up, the ECM will maintain the AFR at 14.6
during idle and part throttle cruise. While the ECM is in
closed loop operation, the ECM will correct for any
attempt to add fuel in these operating ranges.
For off-road racing where AFR changes are
required at idle and part throttle, you can simply
disconnect the sensors. Once the oxygen sensors are
disconnected, you can make AFR changes throughout
the entire engine operating range from idle to wide
open throttle. To maintain your tuned in AFR, leave
the sensors disconnected and tape off the connectors.

Table A - Stage 1 Tuner Settings
Oxygen Sensors Disconnected Or No Original Equipment Oxygen Sensors
Parameter

Fuel Trim Operating Range

0
1
2
3
4
5
6
7
8
9

Display Off
Idle 750-1250 RPM 0% TPS
Low cruise 1250-2000 RPM 2.5-50% TPS
High cruise 2000-3750 RPM 2.5-50% TPS
Wide open throttle 1250-2000 RPM 50-100% TPS
Wide open throttle 2000-2750 RPM 50-100% TPS
Wide open throttle 2750-3750 RPM 50-100% TPS
Wide open throttle 3750-4750 RPM 50-100% TPS
Wide open throttle above 4750 RPM 50-100% TPS
Acceleration enrichment

Stage 1 Mods Stage 2 Mods
12
12
12
8
8
8
8
8
4

15
12
12
15
15
15
15
15
5

Notes:
1. These values will result in a slightly rich initial setup that should be safe for most applications.
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Use the recommended setup table as a starting
point for further tuning. If you have access to a dyno
with an exhaust sniffer, refer to the following section for
more guidelines. If you do not have access to a dyno,
you can utilize our optional Tuners Kit, or you can still
make some adjustments based on the following
guidelines:
1. Aftermarket camshafts will generally increase
manifold pressure (reduce vacuum) near idle. The
speed-density control will compensate with
excessive fuel resulting in a very rich idle. If the
idle still seems rich after using the recommended
settings, try further reducing the idle fuel in -5%
steps.
2. If the engine still runs rough or coughs (backfire
through the intake) under part throttle cruise
conditions, try adding an additional 5-10% fuel in
the RPM ranges where problems are noted.
3. Performance modifications will generally increase
the fuel requirement at wide open throttle. If the
engine still runs rough or hesitates at wide open
throttle, try adding 5-10% fuel in the RPM ranges
where problems are noted.
4. If throttle roll-on response is poor, try using a
higher value for acceleration enrichment.

2. Run the engine at part throttle near the middle of
the RPM and throttle position ranges for low and
high cruise. Trim the fuel so that average AFR
readings are near 14.1. If you observe a lean spot
where AFR exceeds 14.6, add more fuel. You are
always better off with the engine running rich in
some areas than coughing in one particular lean
spot.
3. Performance modifications will generally increase
the fuel requirement at wide open throttle.
However, it is not unusual for some 2-into-1
exhaust systems to have a torque dip at some
RPM point where the engine then runs very rich
and fuel must be subtracted. Do wide open throttle
runs and record AFR values. Target AFR values
at wide open throttle are in the 12.8-13.2 range.
Make appropriate fuel trim adjustments in each
RPM range. High compression engines may
exhibit spark knock at wide open throttle. Spark
knock can often be eliminated by adding more fuel
(AFR in the 12.0-12.5 range) within the affected
RPM range.
4. If throttle roll-on response is poor or a lean
transient (high AFR values) is observed, try using
a higher value for acceleration enrichment.

If you have access to a load control dyno with an
exhaust sniffer, you are in a much better position to
make accurate adjustments.
1. Make sure the engine is fully warmed up and has
reached normal operating temperature. Run the
engine at idle. Trim the idle fuel, while observing
the air/fuel ratio (AFR). Idle AFR should be near
13.8. Few applications will require adding fuel at
idle however for more free flowing the pipes, more
adjustment may be required . Aftermarket
camshafts will generally increase manifold
pressure (reduce vacuum) near idle. The speeddensity control will compensate with excessive
fuel resulting in a very rich idle. If the idle AFR is
still rich after using the recommended settings, try
further reducing the idle fuel in -5% steps. If you
are using sniffer, obtaining an accurate idle AFR
reading may be difficult due to reversion effects.
Reversion will result in a false lean AFR reading. If
the AFR reading is above 14.6 before fuel trim, but
the engine is running reasonably well, you
probably have a false lean reading. The most
accurate reading that can be obtained will be
through our optional Tuners Kit with Wide Band
sensors installed directly into the pipe while
tuning.
Pro Twin Performance Products, 362 Swanson Drive, Lawrenceville, GA 30043
(678) 226-9651 www.protwin.com
Page 10

Freedom Stage 1 Tuner CAN
12/2013

CRIMPING DEUTSCH TERMINALS

Figure 2 – Inserting Wire

The Freedom Tuning Systems Stage 1 Tuner
utilizes Deutsch DT series connector assemblies and
crimping techniques. A “J” hook tool is required to pull
out the green secondary lock on male terminal
housings. This can be fabricated from a section of stiff
coat hanger wire. A small flat screwdriver is used to pry
the orange secondary lock away from female terminal
housings and to release locking tabs.
You must use a proper crimping tool for the
closed barrel terminals we suppply. We offer the
proper crimping tool for purchase. Several other
inexpensive crimping tools in the $30-40 range are
available, such as the Palladin PA1461 available from
Allied Electronics (www.alliedelec.com) or
ProsKit/Eclipse CP-463 available from Amazon
(www.amazon.com). A professional crimping tool,
Deutsch DTT-16-00, is available for about $150 from
LADD Industries (www.laddinc.com). LADD is the
authorized factory distributor for Deutsch and a source
for additional terminals: P/N 0462-201-16141 (female)
and P/N 0460-202-16141 (male).
Insert a terminal in the crimp tool and then use
your finger as shown in Figure 1 to align the terminal
flush with the surface of the tool. Carefully close the
ratcheting tool to the first click. Then supply a very
small amount of pressure to the grip to just firmly hold
the terminal in place. Make sure the terminal is flush
with the surface of the tool, otherwise the crimp
indentations will not be correctly located.

Figure 3 – Correctly Crimped Terminal

Figure 1 – Aligning Terminal

Strip 5/32” insulation from the end of the wire
and insert the wire into the terminal as shown in Figure
2. Close the tool to complete the crimping operation.
The crimped terminal should appear as shown in
Figure 3 with wire strands visible in the inspection hole.
The parts bag includes several extra terminals,
and we suggest that you practice crimping one or two
terminals before starting the installation.
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